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CHAPTER 1

Understanding MediaLog

This chapter answers the following questions:

• What Is MediaLog?

• How Does MediaLog Work?

• What Are the Basic Logging Steps?

What Is MediaLog?

MediaLog is a tool that helps you select and log footage before your
edit session. Although you can log footage with Avid editing system
products, using MediaLog can free up your Avid editing system for
editing rather than for logging footage. After logging shots, you can
use your Avid editing system to digitize and edit the footage. In addi-
tion, you can transfer film to National Television Standards Committee
(NTSC) or Phase Alternating Line (PAL) video, use MediaLog to log
the material, and then transfer the logged shots to an Avid editing sys-
tem for digitizing and editing.

MediaLog is portable; you can install it on a laptop and on most desk-
top computers that are running the Windows NT® or Windows® 98
operating system. To log clips from a source tape, your computer must
be connected to a deck that uses Sony® serial deck protocol. MediaLog
allows you to control the deck while viewing your source tapes and
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selecting the shots for your log. You can also log without a deck and
enter the logging information by hand.

For each shot that you log, MediaLog saves the start and end time-
codes, duration, tracks selected, and tape name.

MediaLog also lets you add new categories of information to your log,
so you can record the scene, take, location, or any other comments that
can help you to identify the footage.

Once you have created a log, the MediaLog Sort command orders your
shots according to criteria you specify. The Sift command uses your
criteria to pick out specific footage, such as all the product shots or all
shots from a certain location.

How Does MediaLog Work?

The MediaLog system uses clips, bins, and projects to organize your
work.

MediaLog clips and bins are a lot like their film counterparts. Just as
film editors pull clips from their raw footage and store the clips in bins
for the editing session, MediaLog lets you select shots from your tapes
and store information about the shots in electronic bins.

A clip corresponds to a shot you select from a tape. Clips contain infor-
mation about your footage such as the start and end timecodes and the
number of video and audio tracks. Clips are stored in electronic bins,
which have built-in database capabilities to help you easily find a spe-
cific shot.

Each time you log clips, you open a bin and use Logging tool controls
to play your tapes, mark the shots, and add the clips to the open bin.

Deck and log controls are in the Logging Tool window.
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A bin is open while you log clips to it.

If you have a log sheet, you can log clips without using a deck. You
type the start and end timecodes for each clip, and then add them to
the bin.

MediaLog uses a project file to organize all the work you do on a sin-
gle job. You must always create a new project or open an existing
project before you can open a bin and log your shots.

As you work on a project, MediaLog remembers the name of each bin
you open and displays a list of bin names in the Project window. The
list is useful for helping you quickly access bins.

Deck controls Log controls

Sample bin
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What Are the Basic Logging Steps?

In each logging session, you should:

1. Start your computer and the MediaLog program.

2. Create a new project, or open an existing project.

3. Create a new bin, or open an existing bin.

4. Prepare to log:

a. Select a video format.

b. Enter Logging mode.

c. Select a source name.

5. Select the tracks you want to log from the tape.

6. Log the clips.

7. Save and organize the bin.

8. Quit the MediaLog application, and shut down the computer.

Bin names

Sample Project
window
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CHAPTER 2

Getting Started

This chapter describes how to set up the hardware and run MediaLog
sessions. This chapter covers the following topics:

• Setting Up the Hardware

• Turning On the Hardware

• Installing MediaLog Software

• Starting the System

• Setting Up Project Files and Folders

• Working with Bins

• Saving Your Work

• Shutting Down

n For information on installing the MediaLog software, see the current
MediaLog release notes.
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Setting Up the Hardware

Make sure your computer meets the following requirements:

• The computer must be running the Windows NT or Windows 98
operating system.

• At least 8 megabytes (MB) of random access memory (RAM) must
be available to run MediaLog (16 MB or more is preferred when
working with large bins).

• Make sure you have enough RAM to run the operating system.
For example, if your system has 8 MB of RAM, allocating 6 MB to
the MediaLog application might not allow the operating system to
function properly.

For a list of decks, see
the Open Me First box
supplied with your
MediaLog system or the
Customer Service FAQs
on the Avid Web site at
http://www.avid.com.

MediaLog can control a deck that uses Sony serial deck protocol and a
timecode reader. You can control a single deck by connecting an RS-
232 to RS-422 serial adapter kit to the modem or printer port of your
computer. MediaLog can also control a deck through V-LAN® VLXi®

connections.

A direct serial video deck connection requires a serial adapter kit that
contains the following items:

• An RS-232 to RS-422 serial adapter

• Two serial cables; male 9-pin connectors at both ends

w The computer and the deck must be off when you are connecting the
serial cable.

To connect a single deck to your computer:

1. Turn off the computer and the deck.

2. Attach one end of the first 9-pin cable to the end of the serial
adapter labeled RS-232.

3. Attach the other end of the first 9-pin cable to the serial port of
your computer.
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n When you attach the cable to the serial port on the computer, note if it is
Port 1 or Port 2. You will have to choose the port in the Avid software.

4. Attach one end of the second 9-pin cable to the end of the serial
adapter labeled RS-422.

5. Attach the other end of the second 9-pin cable to the remote serial
port of the deck.

n Set the deck to REMOTE mode before you attempt to control the deck using
the software.

Turning On the Hardware

To be sure that the computer detects all the attached hardware and to
avoid damage to any component, turn on the hardware in the follow-
ing order:

1. If your computer has media drives, turn on each drive.

The green drive lights flicker on, followed by the amber drive
lights. Wait 15 to 30 seconds for the drives to spin up before you
turn on the computer system; otherwise, the computer will not
communicate with the storage devices successfully.

2. If you will be logging clips by using a deck, turn on the deck.

Set the REMOTE/LOCAL switch on the deck to REMOTE.

3. Turn on the computer.

To your
computer

To your
deck

RS-422 connection

Serial adapter

RS-232 connection
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w Do not disconnect or turn off individual drives while the
computer is on.

You can now install the MediaLog software.

Installing MediaLog Software

To install the software:

1. Insert the MediaLog compact disc into your computer’s CD-ROM
drive.

The MediaLog Installer CD-ROM window opens.

2. Click the Installers button.

The MediaLog Install screen appears.

3. Click Next.

The License Agreement window opens.

4. Read through the License Agreement and click Yes if you agree.

The Choose Destination Location window opens.

c Do not install the MediaLog application on disks where you store
media.

c If you install MediaLog on an Avid editing system, make sure the
MediaLog application is in a folder separate from the Avid editing
system application — each application has its own preferences.

5. Click Next to accept the default location or Browse to find a differ-
ent location.

The Setup Type window opens.

6. Click Next.

The Application Data Location window opens.
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7. Click Next to accept the default location or Browse to find a
different location.

If MediaLog is already installed, you can choose to uninstall it or
to continue with the installation.

8. Click Next.

Installation is complete. You can choose to restart the computer
now or later.

Starting the System

After you install the MediaLog software according to the instructions
in the MediaLog release notes, you are ready to start the MediaLog
application.

To start MediaLog:

1. Turn on the video deck.

2. Set the REMOTE/LOCAL switch on the deck to REMOTE.

3. Turn on the computer.

c Do not start any other Avid editing application on the computer at
the same time as the MediaLog application. The two applications
will conflict with each other.

4. Click the Start button, point to Programs, point to Avid, and then
click MediaLog.

The Open Project dialog box appears.
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5. Select an existing user and project, or create new ones.

Setting Up Project Files and Folders

Each time you start the MediaLog application or close your current
project, the Open Project dialog box appears. The first thing you do in
the dialog box is select an existing user and project or create new ones.

When you start a new project, the system creates a folder for the
project. The system stores this project folder inside the main Avid
Projects folder, which is located on the drive where you installed
MediaLog. Your project folder holds the bins that contain all the mate-
rial you use in the project.

You choose the project’s format when you create the project.

Use the project management tools to organize your bins, which con-
tain the material you are editing, and to adjust the Project settings such
as auto-save preferences or keyboard command layout.

MediaLog project
folders are stored
in the Avid Projects
folder.

Project foldersUser folders
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Only one project can be open at a time. To switch projects, you must
close the current project before opening another project.

MediaLog saves the video format, settings, and bin selection with the
project, so you can stop working on a project and return to it any time.

About Project Files and Folders

A project file, for storing information related to the project, is saved in
a project folder. The project folder has the same name as the project
(for example, Epic Film is stored in the Epic Film folder).

The project folder is saved in the Avid Projects folder, located on the
drive where you installed MediaLog. Backups of the project folder
bins are created and stored in the Attic folder. The project folder con-
tains bins, project files, settings file, and Statistics and Trash folders.

Table 2-1 describes the files and folders in the project.

Table 2-1 Project Files and Folders

File or Folder Description

Project file Stores the information used by the MediaLog
application that makes up the project.

Project Settings file Stores the settings for the project, including any
custom views you create.

Project bins Bins you create in the Project window are stored in
the project folder.

Trash folder Stores files and folders you delete in the Project
window.

Statistics folder For internal MediaLog application use only; this
folder is normally empty.
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Creating a New User

To create a new user:

1. From the pop-up menu, select the folder where you want the new
user folder to be created.

The default folder is Avid Users.

c Do not share user settings between MediaLog and your Avid editing
system application.

2. Click New User in the Open Project dialog box.

The New User dialog box appears.

Current user folder
(pop-up menu)
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3. Type your name in the Name text box.

4. Click OK.

The Open Project dialog box reappears with the new user name.

Creating a New Project

To create a new project:

1. From the pop-up menu, select the folder where you want the new
project folder to be created.

The default is Avid Projects.

2. Click New Project in the Open Project dialog box.

The New Project dialog box appears.

Current project folder
(pop-up menu)
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3. Type a name for the project in the Project Name text box.

If you plan to transfer your work to an Avid editing system, assign
the same name to MediaLog projects and Avid editing system
projects.

c Make sure you do not already have a project by that name on your
Avid editing system, or the MediaLog project will overwrite the one
on the Avid editing system.

If you transfer your MediaLog bins to a project that has a different
name, the name of the source project is included in the tape
names. For example, if you use MediaLog to log clips from Tape1
in Project X, the Avid editing system lists the source of the clips as
Project X:Tape1.

4. Choose a format from the Format pop-up menu:

• 24p NTSC

• 30i NTSC

• 24p PAL

• 25i PAL
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5. If you select 24p PAL, the Film Type pop-up menu appears.
Choose a film type from the menu.

6. If your project will be matching back to a film list, select
Matchback. For more information on setting Matchback options,
see “Choosing Matchback and Film Options” on page 23.

Choosing Matchback and Film Options

If you work with film material in a video project but need to generate
film pull lists or cut lists as well as edit decision lists (EDLs), you must
establish the film format for matching back from your video EDL to a
film list.

To establish matchback and film settings:

1. Select Matchback in the New Project dialog box.

A pop-up menu for key number tracking appears.

2. Choose a film tracking format from the Film Type pop-up menu to
be used in the matchback process.

3. Click OK.

Pop-up
menu
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The system creates the new project files and folder and returns you to
the Open Project dialog box, where the project name is highlighted in
the Avid Projects list.

Selecting an Existing User or Project

To open an existing use or project when you start MediaLog:

1. In the Open Project dialog box, select the user and project you
want to open.

2. Double-click the project folder name.

The Project window opens.

Default folder for
MediaLog projects

List of
project folders
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Using the Project Window

When you select a project, the Project window opens.

Click the Bins button to see a list of bins in the project. Click the Set-
tings button to see the settings for the project. Click the Info button to
see information about the format of the project (for example, PAL or
NTSC).

Clicking the New Bin button creates a new bin in the project. For
instructions, see “Creating a Bin” on page 30.

Displaying Project Bins

Folders in the Project window help to organize the projects. You can
create folders in the Project window by using the Fast Menu button at
the bottom of the window. Bins in the project can then be dragged into
your custom folder.

When you open bins from other projects, the Project window automat-
ically creates an Other Bins folder. Use the Other Bins folder for quick
access links to other bins you have opened outside the current project.

Other Bins folder

Fast Menu button

A closed bin

Trash icon

An open bin

Project window

Close button
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Bins in the Other Bins folder appear in italic and cannot be moved out
of the Other Bins folder.

The Trash icon in the Project window holds your deleted bins and
folders in case you change your mind. These bins stay in the folder
until you choose Empty Trash from the Fast menu. You can drag bins
from the Trash back into the project.

Displaying Project Settings

The Settings scroll list can be displayed in different ways, depending
on what you need to view.

To change a Project Settings display:

1. Click the Settings button in the Project window.

The Settings scroll list appears.

2. Choose a settings display from the Settings menu, or click the Fast
Menu button.

Settings menu

Fast Menu button

Settings scroll list

Settings button

Close button
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Table 2-2 describes the Project Settings menu options.

Table 2-2 Project Settings Menu Options

Option Description

All Settings Displays all settings available in the Avid editing
system.

Base Settings Displays Project settings only; no views are
displayed.

Bin Views Displays all the Bin View settings you created.

Timeline Views Displays all the Timeline View settings you
created.

Title Styles Displays all the templates you created for the
Title tool.

Video Tool Settings Displays all the Video Tool settings.

Import Settings Displays all the Import settings.

Export Settings Displays all the Export settings.

Workspaces Displays all the Workspace settings you created.
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Displaying Project Information

The Project window includes an Info button that opens the Info win-
dow. Click the Fast Menu button at the bottom of the Info window to
display the menu items: Profile, Usage, and Memory.

To change a Project Info display:

1. Click the Info button in the Project window.

The Info window opens.

2. Choose Profile, Usage, or Memory from the Fast menu.

Table 2-3 describes the Project Info options.

Fast Menu button

Table 2-3 Project Info Options

Option Description

Profile Displays basic project information, such as the video for-
mat (NTSC or PAL) or frame rate (24 fps for film projects).

Usage Gathers and reports information on the system usage by
project. The file information is formatted so you can use it
as input to software programs such as analysis applica-
tions, spreadsheets, or report generators.

Memory Displays the Memory window, which shows the amount of
system memory used by the project.
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Closing a Project and the Project Window

To close a project and the Project window:

1. Click the Project window to activate it.

2. Do one of the following to close the Project window:

• Choose Close from the File menu, or press Ctrl+W.

• Click the Close button in the upper right corner of the
window.

The application automatically saves and closes the project. The
Open Project dialog box appears.

3. Create a new project or select an existing project, or click Quit to
quit the MediaLog application.

Working with Bins

The Project window displays a list of bins. Bins store your clips and
the sequences you create. Anytime after you select a project, you can
create a new bin. You can also open bins created for other projects.

To view the bins in the project, click the Bins button in the Project win-
dow. After closing a bin, you can reopen it by double-clicking its icon
beside the name in the Project window. You can rename the bin by
double-clicking the bin name and typing the new name.
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Avid bins function most efficiently when they contain no more than
100 clips. If you work with a lot of source material, you can create a
number of bins, each named according to the type of shots it will con-
tain. Then you can log an optimal number of clips to each bin.

Creating a Bin

If multiple windows are open on your desktop, you must make the
Project window active before you can create a bin.

To create a new bin:

1. Do one of the following to activate the Project window:

• Click the Project window.

• Choose Project from the Tools menu, or press Ctrl+9.

2. Click the Bins button.

Close button
Bins button

Bin icon;
double-click
to open.

Fast Menu
button

New Bin button

Bin name;
double-click
to rename.
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3. Do one of the following to create the bin:

• Click the New Bin button in the Project window.

• Choose New Bin from the Fast menu.

• Choose New Bin from the File menu, or press Ctrl+N.

A new bin appears and uses the same name as that of the Avid
Project folder but appends a number to it. This name also appears
in the list of bins in the Project window.

4. To change the default name of the bin, select the name in the
Project window and type the new name.

5. Press Enter.

Closing a Bin

To close a bin, do one of the following:

• Click the Close button to save and close the bin.

• Activate the Bin window and choose Close Bin from the File menu
to save and close the bin, or press Ctrl+W.

Close button
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Reopening a Bin

You can reopen a bin or several bins that are already in the project.

To reopen a bin:

1. Click the Bins button in the Project window to see a list of bins.

2. Double-click the icon beside the name of the bin, in the Project
window, you want to reopen.

To reopen several bins:

1. Click the icon of one of the bins.

2. Ctrl+click each additional bin you want to reopen.

3. Do one of the following to open the bins:

• Choose Open Selected Bins from the File menu, or press
Ctrl+O.

• Choose Open Selected Bins from the Fast menu.

• Double-click the icon beside the name of any selected bins.

Removing Bin Names from the Current Project

In the Project window, you can delete the name of a bin you no longer
need to use for the current project without destroying the bin itself. If
necessary, you can reopen the bin later by using the Open Bin com-
mand. See “Opening Bins from Other Projects” on page 33.

To remove a bin name from the current project:

1. Click the Bins button in the Project window to see a list of bins.

2. Select the bin you want to delete from the list.
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3. Do one of the following to remove the bin:

• Press the Delete key.

• Choose Delete Selected Bins from the Edit menu.

• Choose Delete Selected Bins from the Fast menu.

A Trash icon containing the deleted bins appears in the Project
window.

Opening Bins from Other Projects

You can open bins created for other projects.

To open a bin from a different project in your current project:

1. Do one of the following to activate the Project window:

• Click the Project window.

• Choose Project from the Tools menu, or press Ctrl+9.

2. Click the Bins button.

3. Do one of the following to open a bin:

• Choose Open Bin from the File menu, or press Ctrl+O.

• Choose Open Bin from the Fast menu.

The Open dialog box appears.
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4. Select the project folder that contains the bin you want to open.

5. Do one of the following to select the bin:

• Double-click the icon beside the name of the bin.

• Select the bin and click Open.

• Select the bin and press Enter.

The bin name is added to an Other Bins folder in the Project
window.

Project folder

Bin to be opened
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Retrieving Bin Files from the Attic Folder

You retrieve files from the Attic folder in the following circumstances:

• When you want to replace current changes to a sequence or clip
with a previous version

• When the current bin file becomes corrupt

When a copy of a bin file is stored in the Attic folder, the system adds
the file name extension .bak plus a version number to the bin name.
When you view the Attic folder in the Details view, you can identify
the most recent backup file based on the name and timestamp of cre-
ation displayed in the Date Modified column.

To retrieve a file from the Attic folder:

1. Close all your bins in the Project window.

2. Navigate to the Attic folder.

3. Open the Attic folder.

4. Choose “Details” from the View menu if the Folder window is not
already in view.

5. In the Attic folder, open the project you want to retrieve, and then
select the bin files you want.

6. Drag the backup bin files to the desktop. This makes a copy of the
files, leaving the original files in the Attic folder.

7. Click the Project window to reactivate it.

8. Choose Open Bin from the File menu, or press Ctrl+O. Select one
of the backup bins on the desktop and click Open.

When you open the backup bin, a link to that backup bin is created
in the Other Bins folder.

n The MediaLog application does not allow a bin and copy of a bin to be opened
at the same time. You must keep all other bins closed and open the backup bins
one at a time. The creation date might need to be changed to avoid conflicts.
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9. Create a new bin from the Project window.

10. Select the material you want to keep from the backup bin and drag
the duplicates to the new bin.

Repeat steps 8 to 10 for any other backup bins you copied to your
desktop.

11. Select and delete the backup bins in the Other Bins folder.

12. Click on the desktop and drag the backup copies of the bins to the
Recycle Bin on the desktop.

Saving Your Work

Save your work frequently to avoid losing what you have done.

Your most recent work is stored only in the volatile, random-access
memory (RAM) of the computer system until you save the informa-
tion on a hard disk, either explicitly or by automatically saving.

Should the power fail or the system shut down unexpectedly, the
project and bins stored in RAM are lost. You can restart the editing
session by opening the project and bins saved on disk.

Saving a Bin

To save a single bin:

1. Click the bin to activate it.

2. Choose Save Bin from the File menu, or press Ctrl+S.

The Save Bin command dims if the current bin has already been
saved.
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Saving All Bins

To save all bins:

1. Click the Project window to activate it.

2. Choose Save All from the File menu, or press Ctrl+S.

The system saves all the bins that are currently open. At the same
time, it saves your Project settings.

Saving a Copy of a Bin

To save a copy of a bin:

1. Click the bin to activate it.

2. Choose Save Bin Copy As from the File menu.

The Save dialog box appears.

3. Select the disk and folder where you want to save the copy.

4. Type a new name for the copy and click Save.

Setting Auto-Save Bin Preferences

Remember to save your project and bins while you work. For added
safety, MediaLog automatically saves a backup copy of your files
every few minutes. It also saves a backup copy each time you explic-
itly save a file yourself and when you close a bin or a project.

Backup files are labeled with the name of the bin and a .bak file name
extension. They are stored in the Attic folder. An Attic folder is auto-
matically created for each project and stored in the project folder.

The system adds backups to the Attic folder until a maximum number
is reached. By default, the system automatically saves every 15 min-
utes and keeps a maximum of 30 backup files in the folder.
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You can specify how many backup copies of each file can be saved.
Once this maximum is reached for a bin, every new version of a
backup file replaces an older version of the same file. If, when the Attic
folder is full, you want to add a new version of a file that has not met
the maximum, the new version replaces the oldest file in the folder.

To change the default auto-save settings for a project:

1. Click the Settings button in the Project window.

The Settings scroll list appears.

2. Double-click the Bin setting.

The Bin Settings dialog box appears.

Settings button

Settings scroll list

Bin setting
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3. Enter the auto-save values you want.

4. Click OK.

Backing Up Files

To back up your files:

1. Insert a formatted floppy disk into the floppy drive.

2. Open the project folder that contains your projects and bins.

Project folders are usually stored within the Avid Projects folder.

3. Double-click the 31/2 Floppy (A:) drive icon (usually drive A) to
navigate to the disk or to a folder on the disk where you want to
store the backup files.

4. Drag the Bin icon, Project icon, or the entire project folder (with
bins and projects enclosed) to the floppy disk.

5. When the system finishes copying the files, remove the floppy
disk.
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Shutting Down

At the end of a logging session, you can either close the project and
open another, or you can quit the MediaLog application and shut
down the system.

c When you quit MediaLog, it automatically saves the current project
folder, project file, and bin inside the Avid Projects folder. However,
if the files are destroyed or lost, your work will be lost. Make sure to
back up your project and bins. See “Backing Up Files” on page 39.

Quitting the MediaLog Application

To close a project before shutting down the computer:

• If a project is open, choose Quit from the File menu, or press
Ctrl+Q.

• If no project is open, click Quit in the Open Project dialog box.

The application saves your project and bins before it quits.

Turning Off the Hardware

c Failure to shut down the computer first before shutting down the
remaining hardware could damage the computer or the storage
disks for the system.

To shut down the hardware at the end of each session:

1. Quit the MediaLog application.

2. Choose Shut Down from the Start menu to turn off the computer.

3. Turn off the external drives and all other hardware connected to
the system (for example, decks and monitors).
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CHAPTER 3

Logging Source Material

You use MediaLog to log your clips in preparation for digitizing later
in Avid editing system products.

This chapter describes the following tasks:

• Understanding Logging

• Configuring Decks

• Preparing to Log Material

• Logging

• Creating Avid Logs

• Importing Logs

Understanding Logging

MediaLog requires that you name the clips that you log, the tapes they
came from, and their start and end timecodes. Many editors prefer to
log all their clips (shots) first and then batch digitize their material
later in the Avid editing application.

The three basic methods for producing a bin or log that can be used
later for batch digitizing are:
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• Logging directly to a bin

• Importing standard log files to a bin

• Creating Avid logs

The MediaLog tools automate the process of recording each clip’s start
and end timecodes, track selection, and other important data. You do
not need to enter information manually. However, if a source deck is
unavailable, or if you have already logged the data on paper, you can
manually record clip data in a bin.

The logging tools provided in MediaLog are also available in the
Avid editing system products. Bins that you create with MediaLog are
completely compatible with your Avid editing system product — you
can copy MediaLog bins to the Avid editing system to begin working
with the logged footage.

Configuring Decks

The MediaLog application provides a feature that will automatically
configure your attached deck. Each time you exit the MediaLog appli-
cation, the deck configuration settings are saved. If you reconnect the
deck to a different port, or attach a new deck, you must run the auto-
matic deck configuration feature again.

If MediaLog does not automatically sense your attached deck, you
must manually configure the deck.

n MediaLog will not override the configurations that were manually specified.



43

Automatic Deck Configuration

Use the automatic configuration feature before manually trying to con-
figure any attached deck. If the automatic feature does not sense your
attached deck, see “Manual Deck Configuration” on page 43.

To automatically sense the attached deck, choose Autoconfigure All
Ports from the Special menu.

MediaLog searches the system ports and configures the attached
decks.

Manual Deck Configuration

MediaLog offers an alternative method of configuring your deck if it
cannot be automatically configured. You can manually configure sin-
gle or multiple decks even if the decks are not currently attached to the
system. Stored deck configurations can also be deleted.

The Deck Configuration and Deck Preferences settings appear as sepa-
rate items in the Settings scroll list of the Project window.
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Deck Configuration Settings

Deck Configuration settings allow you to establish deck control
parameters for a single deck or for multiple decks. You can create mul-
tiple versions, allowing you to select them for frequent changes
in hardware configurations.

c You must manually configure the appropriate hardware connections
before Deck Configuration settings can take effect. For more infor-
mation, see the setup guide to your Avid editing system.

To configure a deck or multiple decks:

1. Double-click Deck Configuration in the Settings scroll list of the
Project window.

The Deck Configuration dialog box appears.

Deck settings
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2. Click Add Channel to add a new channel box and automatically
open a Channel dialog box.

n Channel refers to the signal path for deck control, whether through a serial
port or a V-LAN VLXi system.

3. Choose either Direct (serial port) or V-LAN/VLXi from the Chan-
nel Type pop-up menu, depending on your system configuration.

4. If you chose Direct for the channel type, choose either no port or
one of the other ports from the Port pop-up menu.

A message box appears, asking if you want to autoconfigure the
channel now.

5. Click No.

6. Click OK to close the Channel dialog box.

A new channel appears in the display area of the Deck
Configuration dialog box.
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n You can reopen the Channel dialog box to change the options at any time by
double-clicking the channel box.

7. Click the channel box to select it.

8. Click Add Deck. The Deck Settings dialog box appears.

9. Configure Deck settings based on the information in Table 3-1.

Channel boxes
appear on the left.
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n If you already have a deck connected to the system, you can also click
Auto-configure to bypass the Deck Settings dialog box and automatically con-
figure a deck with the default settings.

Table 3-1 Deck Settings

Option Description

Name Includes a text box for typing your own custom name for the video deck.
The default name matches the deck type.

Description Includes a text box for entering notes about the deck.

Deck Type Provides a list of supported decks. For accurate deck control, choose your
manufacturer and model from the menu.

Address For V-LAN VLXi use only (see your V-LAN VLXi documentation). If you
are using direct serial port deck control, this option remains dimmed.

Preroll Determines how many seconds you want the tape to roll before a digitize
or digital cut starts. The default is based on the type of VTR.

Fast Cue Fast cue is useful only for decks that can read timecode in fast forward or
rewind mode. If your decks can do this, fast cue can speed long searches.

Switch to ff/rew This option instructs the system to switch to fast
forward or rewind if the target timecode is farther
than the specified number of seconds from your
current location on the tape.

By default, the deck switches to fast forward or
rewind to reach a target timecode that is more than
60 seconds away.

If your deck shuttles very quickly, you can increase
this number so that the system uses fast cue only
for long searches.

Switch to search This option instructs the system to switch out of
fast forward or rewind when it is within the speci-
fied number of seconds of the target timecode. By
default, the system switches to search mode when it
is 14 seconds from the target timecode.
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10. Click OK to close the Deck Settings dialog box and return to the
Deck Configuration dialog box.

n You can reopen the Deck Settings dialog box to change the options at any time
by double-clicking the box that displays the selected deck.

11. Repeat steps 2 to 10 for each additional channel or deck you want
to configure.

12. Click Apply to complete the configurations and close the Deck
Configuration dialog box.

n See “Deck Preferences” on page 49 to adjust global deck control options for
default timecode format, assemble editing, stop key, and shuttle operation.

Channel boxes
appear on the left.

Decks
appear on the right.
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Deleting Deck Configurations

You can remove or replace deck configuration elements from the Deck
Configuration dialog box.

To delete deck configuration elements:

1. Double-click Deck Configuration in the Settings scroll list of the
Project window.

The Deck Configuration dialog box appears.

2. Click a channel box, a deck box, or the entire configuration to
select it.

3. Click Delete, or press the Delete key.

4. Click Apply.

Deck Preferences

Deck preferences are global settings for basic deck control. These set-
tings apply to all decks connected to your system, regardless of your
deck configuration. You can open the Deck Preferences dialog box
from the Settings scroll list of the Project window.

Table 3-2 lists the Deck Preferences window options.
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Preparing to Log Material

MediaLog provides two special tools for logging source material:

• The Logging tool, which contains:

- Source deck controls

- Marking and logging controls

- Active track controls

Table 3-2 Deck Preferences

Option Description

When no tape in deck
log as

Displays a pop-up menu that lets you choose the default timecode for-
mat (Drop Frame or Non-drop Frame) to use when logging clips with-
out a tape in the deck. If a tape is in the deck, the MediaLog application
automatically uses the existing timecode format on the tape.

Allow assemble edit
for digital cut
(This option is not
used in MediaLog.)

Allows you to use assemble-edit features in the Digital Cut tool, along
with assemble-editing capabilities of your record deck, to quickly
record frame-accurate digital cuts without striping entire tapes in
advance.

Stop key pauses deck Defines the behavior of the keyboard’s space bar. If you select this
option, the space bar acts like the Pause button on the Deck Controller
tool. If you deselect this option, the space bar acts as the Stop button.

If the videotape heads are down in “Stop key pauses deck” mode,
pressing the space bar brings up the heads and pauses the deck.

The Stop button on the Digitize tool and Deck Controller tool always
stops the decks. (Choose New Deck Controller from the Tools menu to
access the Deck Controller tool.)

Shuttle holds speed Determines whether the Shuttle button will continue shuttling at a con-
stant speed or stop when you release it.

Stop any paused decks
when quitting

Stops any running decks when you quit MediaLog.
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- Timecode information

- Deck, bin, and tape name information

- Comment section

- Message area

• The Compression tool, which provides information about the
audio rate

Accessing and Setting Up the Logging Tool

Once you have opened or created a bin, use the Logging tool to enter
the name of the tape you are logging and to access deck and logging
controls.

Use the Logging tool to plan a naming scheme; to work with source
tapes; and to select tracks, bins, and sources.

To access the Logging tool, do one of the following:

• Click in a Bin window to activate it, and then choose Go To
Logging Mode from either the Bin menu or the Fast menu, or press
Ctrl+B.

• Choose Logging from the Tools menu, or press Ctrl+7.

To select the appropriate source deck, source tape, target disk, and
active track settings for your captured material:

1. Open or create your project and the bin in which you want to store
your master clips. For information about opening projects and
bins, see Chapter 2.

2. Choose Go To Logging Mode from the Bin menu, or press Ctrl+B.

The Logging Tool window opens.
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Guidelines for Naming Tapes

Consider the following naming guidelines when you provide a name
for your tape:

• Devise a naming scheme. Although tapes of similar names are
easy to sort and view together in a bin, distinguishing among
them might be difficult when you try to quickly locate a specific
tape. Name the tapes based on the amount and complexity of your
source material.

• Use unique names. The system cannot distinguish between two
tapes with the same name and between two bins or clips with the
same name. For example, if two tapes are named 001, you might
encounter problems correctly associating their clips with the cor-
rect physical tapes.

• Use alphanumeric characters (A–Z, 0–9), with no spaces before the
name. Characters can be uppercase and lowercase. The maximum
length of a name is 31 characters.

n Although the maximum length of a name is 31 characters, most online houses
will accept tape names of no more than 6 characters.

Channel Selection
area

Logging button

Enable timecode
button

Triangular opener

Deck controller
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• Select a case convention and maintain it throughout a project. A
single tape can be listed as several different tapes if you alter the
case of the letters. For example, if you type a single name as
SUNSET, Sunset, and sunset on three different occasions, all three
names appear. This can cause problems when keeping track of
clips during the logging process.

• Be cautious when changing a tape’s name. After you provide a
name for a tape source, any change to the tape’s name automati-
cally changes that tape name everywhere it occurs. If you decide
later to change the name of one of the tapes from 001 to 999, every
reference to tape 001 changes to a reference to tape 999.

Inserting Source Tapes

To insert a source tape in a deck to prepare for logging source material
with MediaLog:

1. Set the REMOTE/LOCAL switch on the deck to REMOTE.

2. Insert a tape in the deck.

3. Choose Go To Logging Mode from the Bin menu, or press Ctrl+B.

The Deck Controller appears as part of the Logging Tool window.

Source tape timecode

Source tape displayDeck Name

Single-Frame Backward button

Single-Frame Forward button
Rewind button

Eject button
Stop button

Shuttle button

Fast Forward button

Play button

pop-up menu

Valid timecode indicator

Pause button
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Selecting Active Tracks

The Logging tool captures information about the active tracks.

MediaLog automatically activates the tracks that were active in the
previous session. Change these settings by clicking tracks in the
Channel Selection area of the Logging Tool window to activate or
deactivate them.

Selecting the Bin

To select the bin in which you want to organize your logged material:

1. Click the Bin pop-up menu in the Logging Tool window.

The pop-up menu lists all open bins.

2. Select the bin you want to use.

If the pop-up menu does not list the bin you want, either open an old
one or create a new bin from the Project window as follows:

• Open a previously created bin by choosing Open Bin from the File
menu or by pressing Ctrl+O.

• Create a new bin by choosing New Bin from the File menu or by
pressing Ctrl+N.

Selecting the Source Deck

In some cases, your source material might not reside on a video deck.
You can also select other source devices, such as a digital audiotape
(DAT). Be sure the source material has readable timecode.

To select the deck where the source material is found:

1. Click the Deck Name pop-up menu to display the available online
decks.

2. Choose the name of your source deck from the pop-up menu.
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Identifying the Source Tape

To specify the source tape’s name:

1. Insert a tape in the deck.

The Select Tape dialog box appears.

2. Double-click the name of a tape listed in the dialog box.

3. If the name of the tape is not shown in the list:

For information on
naming tapes, see
“Guidelines for Nam-
ing Tapes” on page 52.

a. Click New.

A new tape name line appears at the bottom of the dialog box.

b. Type the tape name.

c. Press Enter.

Using the Compression Tool

Before you begin logging, you must choose an audio compression rate.
The Compression tool lets you digitize your audio at either 44.1 kHz
or 48 kHz.

To access the Compression tool, choose Compression from the Tools
menu, or press Ctrl+5.

The Compression Tool dialog box appears.
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Make sure the correct audio sample rate is indicated under Audio
Rate. The audio sample rate is adjustable within the Compression tool.

If you select Batch Digitize in your Avid editing system and then select
“Use the audio compression rate logged for each clip,” you must digi-
tize at the same rate as the audio rate at which you logged.

Logging

The following methods are available for logging:

• From a source tape

• On-the-fly

• With the deck offline

Logging from a Source Tape

One method of logging is to use MediaLog tools to control a source
deck, to select shots or clips from your source tapes, and to record clip
data directly to a bin.

Make sure you have set up all the required information for logging, as
described earlier in this chapter. After you establish your settings and
specify your bin, deck, and tape, the Logging tool is the only tool you
need to log from a tape to a bin.

Audio settings
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The Logging tool provides flexibility in the way you mark your clips
for logging, as the following illustration shows.

Marking and Logging

The basic logging procedure involves marking IN and OUT points.
You mark IN and OUT points either by using the Mark buttons or by
typing IN and OUT timecodes.

The icon in the Logging button changes according to the stage of log-
ging you are in. When the Logging button appears as a pencil,
MediaLog is ready to log the clip.

To log clips directly from a source tape to a bin:

1. Insert your tape in the deck.

Logging
button

Timecode entry
text boxes

Mark IN button

Mark OUT button
Duration Mark button

Mark MEMORY button Clear MEMORY button

Go To MEMORY button

Go To IN button

Go To OUT button

Clear IN button

Clear OUT button

LoggingMessages
bar

Channel Selection
area

Clip name and
Comment heading

Source tape
display

Bin name
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The Logging Messages bar displays the message “Mark IN,” indi-
cating the system is waiting for you to mark an IN point. The
Logging button displays a Mark IN button.

2. By using the Play or Shuttle buttons in the deck controller area,
move to the point where you want to mark IN or OUT points for a
clip.

3. Mark an IN or an OUT point by doing one of the following:

• Click the Logging button to mark the IN point.

• Mark the IN or OUT point.

• Enter the timecode for the IN or OUT point.

The timecode appears and the Logging Messages bar displays the
following message: “Mark OUT and Log” or “Mark IN and Log.”

4. Mark the remaining IN or OUT points by doing one of the
following:

• Move to the point where you want the other mark (IN or
OUT) and mark it by using the Mark buttons.

• Enter the timecode for the IN or OUT point.

• Enter the timecode for the duration.

The system calculates the appropriate timecode for the remaining
IN point, OUT point, or duration.

c You must enter at least two of the three timecode marks (IN point,
OUT point, or duration) to complete the log entry.

If you want to change either the IN point, the OUT point, or the
duration before you log the clip, you can do one of the following:

• Move to the new IN or OUT point, and click the Mark IN or
Mark OUT button.

• Highlight the IN or OUT timecode and type the new one, or
click the Clear IN or Clear OUT button and type the new time-
code.
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5. Log the clip by clicking the Logging button.

The clip is logged to the bin.

The clip name, which the system chooses and numbers, is high-
lighted in the bin and is ready to be changed. The default
clip name is the bin name plus a number.

6. Type a new name for the logged clip in the bin, and press Enter.

n You should change the clip name immediately. Forgetting the contents of each
clip among the dozens you log is easy to do.

7. Repeat these steps until you have logged all your clips.

Logging While Marking an OUT Point or an IN Point

If you have already marked an IN point, the timecode for the IN point
is displayed and the icon in the Logging button changes to a mark
OUT and a pencil.

To mark an OUT point and log at the same time:

1. Move to where you want to mark an OUT point.

2. Click the Logging button.

The clip is logged to the bin.

If you have already marked an OUT point but have not marked an IN
point, the timecode for the OUT point is displayed and the icon in the
Logging button changes to a mark IN and a pencil.

Using the Go To Buttons

You can use the Go To buttons to the right of the timecode entry text
boxes to cue the tape to that point.

Mark OUT
and pencil

Mark IN
and pencil



60

To use the Go To buttons:

1. Type the approximate timecode of the IN or OUT point for the
clip.

2. Click the Go To IN or Go To OUT button to the right of the
timecode entry text box.

The Logging tool automatically cues the tape to that point.

3. Use the deck controls to move to where you want to mark
an IN point or an OUT point.

4. Click the Logging button.

The clip appears in the bin.

Logging On-the-Fly

You can log clips while the tape is playing. This is called logging on-
the-fly. Logging on-the-fly requires the preparation described in the
following sections:

• “Selecting the Source Deck” on page 54

• “Identifying the Source Tape” on page 55

• “Using the Compression Tool” on page 55

• “Importing Log Files into MediaLog Bins” on page 65

You can log on-the-fly whether or not you already know where you
want to mark the IN and OUT points in your clips.

To log on-the-fly:

1. Insert your tape in the deck.

2. Open the bin where you want to store the clips, or create a new
bin.

3. Choose Go To Logging Mode from the Bin menu, or press Ctrl+B.
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4. Select the audio and video tracks you want to digitize and their
tape name.

5. Step (jog), shuttle, or play the tape to the point where you want to
begin logging material; then follow the steps in “Marking and
Logging” on page 57.

Logging with the Deck Offline

You can also log material without controlling a source tape deck. If the
deck is not connected or not working, or if the tape is not available,
you can still log material as long as you know the timecodes.

To log without a deck or tape:

1. Double-click Deck Preferences in the Settings scroll list.

The Deck Preferences dialog box appears.

2. Choose either Non-drop Frame or Drop Frame from the pop-up
menu. This selects the timecode format for logging.

3. Click OK to close the Deck Preferences dialog box.

4. Make sure a bin is selected and choose Go To Logging Mode from
the Bin menu, or press Ctrl+B.

5. Click the tape name display.

A dialog box appears.
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6. Click Yes to open the Select Tape dialog box.

7. Do one of the following:

• Double-click the name of the tape.

• Click New, type the name of the tape you want to log, and
then click OK.

• Select the name from the list and then click OK.

8. In the Channel Selection area in the Logging Tool window, click
the tracks you want to log. For example click V, A1, and A2.

9. Type the start timecode in the Timecode entry text box for mark
IN, and press Enter.

10. Type the end timecode in the Timecode entry text box for mark
OUT, and press Enter.

11. Click the Logging button (which now displays a pencil icon).

The clip is logged to the bin.

12. Rename the clip.

List of tapes
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Creating Avid Logs

You can use a text editor to log your source footage manually. An Avid
log lists video clips you want to capture for editing. You can create the
logs in Avid format, entering data about your source tapes and clips
according to Avid specifications.

You can also modify an incompatible log to make it conform to Avid
specifications. To prepare an Avid log on any type of computer, use
any text editor. After you create logs, you can import them directly
into MediaLog bins.

Appendix A describes the format specifications for an Avid log, which
includes the following information:

• Global headings

• Column headings

• Clip data

Appendix A also includes a sample Avid log.

Make a separate log for each videotape, or log clips from several dif-
ferent videotapes in one log. After you manually create an Avid log,
you can import it into MediaLog as described in “Importing Log Files
into MediaLog Bins” on page 65.

Importing Logs

Many logging programs and film-to-tape transfer systems create logs
you can import into your MediaLog project. You can open some logs
directly in MediaLog bins; others must be converted to Avid format
first.
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Importing Standard Log Files

If you are transferring film to video for logging in MediaLog, ask
the transfer house to log the source footage during the film-to-tape
transfer. You can import some standard film-to-tape logs directly into
MediaLog bins. Many other film-to-tape logs can be converted to
Avid format by using Avid Log Exchange and then imported into
MediaLog. A number of video logging systems also produce files you
can import into a MediaLog bin.

Compatible Logs

Use the Import command, in the File menu, to import these files to a
MediaLog bin:

• Avid Log Exchange (ALE)

• Log Right (file names that have the .ale file name extension)

• Excalibur (file names that have the .ale file name extension)

• Shot Lister

• MediaLog/PC

• Avid logs you create yourself, using a text editor (See “Creating
Avid Logs” on page 63 for Avid log specifications.)

• Logs converted into Avid format by using Avid Log Exchange
(file names that have the .ale file name extension)

n Avid recommends that you convert any files not created on an Avid system
into Avid format by using Avid Log Exchange.

Use the Avid Log Exchange utility to convert these logs to Avid format
before importing into a MediaLog bin:

• Log Producer

• AatonBase (file names that have the .flx file name extension)
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• FLEx (file names that have the .flx file name extension)

• Evertz

For more information about converting a log to the Avid format,
see the information on Avid Log Exchange in the user’s guide to your
Avid editing system.

Importing Log Files into MediaLog Bins

To import log files into a MediaLog bin:

1. Open a bin and click to select it.

2. Choose Import from the File menu.

The Import file(s) into bin dialog box appears.

3. Navigate to the drive and then to the folder that contains the log
file you want to import.

If the log is on a floppy disk, insert the disk into the floppy drive.

4. If you want to adjust import parameters for the shot log, click the
Options button.

The Import Settings dialog box appears. Select one of the follow-
ing options and click OK:

• Combine events based on scene and automatically create
subclips. Combines all events for a scene into a single master
clip and then links the master clip to subclips that represent
the original events for that scene. To use this option, you must
have scene numbers logged in a scene column in the bin.

• Combine events based on camera roll and automatically cre-
ate subclips. Combines all the events from a camera roll into a
single master clip and then links the master clip to subclips
that represent the original events for that camera roll. To use
this option, you must have camera roll numbers logged in a
camera roll column in the bin for a film project.
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• Merge events with known sources and automatically create
subclips. Automatically creates subclips for those events that
are merged or relinked to their source clips upon import. Use
this option if you have already entered master clips in a bin for
each camera roll or master scene, and subsequently logged all
the events related to those clips for import.

• Merge events with known master clips. Automatically cre-
ates subclips for those events that are merged or relinked to a
selected master clip based upon matching tape name. Use this
option if you have already logged (or digitized) master clips in
a bin for each tape.

5. Select the file or files you want to import, and click Open.

The bin fills with master clips derived from the information in the
imported shot log. Any additional information logged with each
clip is also imported.

6. To save the new master clips that came from importing the log,
save the bin.

Transferring Bins from Another MediaLog System

MediaLog bins are interchangeable with those of other releases. In
general, later releases of the MediaLog application accept bins from
earlier releases.

Use the following procedure to transfer a bin from one MediaLog
system to another MediaLog system.

1. Save MediaLog project bins from the first MediaLog system on a
floppy disk.

2. Go to your second MediaLog system, and quit or hide the
MediaLog application.
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3. Double-click the Avid Projects folder, located where you installed
MediaLog. Then double-click the project folder where you want to
store MediaLog bins.

Project folders are generally stored inside the Avid Projects folder.

4. Insert the transfer floppy disk into the floppy drive on the second
MediaLog system.

5. Navigate to the floppy drive.

Position the floppy drive window and your MediaLog project
folder window so you can see both.

6. Select the MediaLog bins in the floppy drive window, and drag
them to your MediaLog project folder.

When you start your MediaLog program, open the imported bins
in the same way you open standard MediaLog bins.
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CHAPTER 4

Organizing Clips and Bins

After creating clips, you can rename, subcatalog, sort, sift, select,
duplicate, and delete them. You can also analyze the clips in a Bin
view.

This chapter describes the following tasks:

• Organizing Clips and Sequences

• Viewing Clips in a Bin

• Customizing Bin Views

• Renaming Clips

• Selecting Clips

• Deleting Clips and Sequences

• Duplicating Clips

• Copying Timecode Information

• Displaying Specific Clip Types

• Sorting and Sifting Clips

• Moving or Copying Clips to Other Bins

• Modifying Clip Data in a Bin
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Organizing Clips and Sequences

MediaLog provides powerful database tools for organizing and man-
aging source material. You can use these tools as much, or as little, as
you need to do the following:

• Rename each clip, using a descriptive phrase or a line from the
script.

• Add information about each clip in bin columns you create and
define. For example, you can label the clip to indicate the type of
shot or location.

• Subcatalog long clips by breaking them up into shorter subclips.

• Keep all clips that meet specific criteria in a single bin created for
that purpose. For example, all the close-ups can go in the Closeup
Clips bin.

• Print the bin with all the information you have added and the data
automatically captured by MediaLog.

• Export the bin information to an ASCII file that can be imported
into a database or spreadsheet file.

Viewing Clips in a Bin

Clips are listed in a text format. The setting you choose or create
defines the placement of the column headings for that bin.
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Each time you modify the current view of the bin, the view’s name
changes to italic, indicating that the change you made is temporary
until you save the view. Also, MediaLog appends a number to the
temporary view name. If you do not save this view, and continue to
make changes, the appended number is incremented. At anytime, you
can choose Save As from the Bin View pop-up menu to permanently
save any of the temporary views you have just created.

If you try to select a new Bin View setting while the current setting is
Untitled, a message box appears, asking if you want to discard the cur-
rent setting.

MediaLog bins have three default Text views:

• Custom — The only required heading in this view is the clip
name. You can customize the view by adding or hiding statistical
column headings. Statistical information is created when you digi-
tize the footage; it cannot be changed later.

• Film — This Bin view has film-related column headings.If you
work on a project that is not film-related, and you select the Film
Bin view, a message box informs you that only non-film-related
columns will be displayed.

• Statistics — The standard statistical column headings are derived
from information established during logging.

Sample bin

Text View button

Fast Menu button

List of clips

Bin View pop-up menu
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Table 4-1 shows the bin column headings available in Text view (in
addition to any column headings you might want to create for your
bins).

Table 4-1 Bin Column Headings

Heading Description

Name This heading does not appear in the Headings list, but it always appears in the
clip. This heading contains the name of the clip or sequence (you can rename a
clip or sequence after it has been digitized).

Audio The audio resolution (sample rate).

Audio Format The audio format of master clips.

Auxiliary Ink Auxiliary ink format settings allow you to display two types of ink numbers
at the same time. This lets you track additional types of film information for dif-
ferent film gauges.

Auxiliary TC1
through TC5

You can enter an auxiliary timecode, for example, Aaton, ARRI, or some other
timecode for editing film or audio timecode for film.

CFPS The captured frames per second.

Camera The camera that captured this clip. This feature is used in multicamera shoots.

Camroll The camera roll containing this clip.

Color The color of the bin objects.

Color Framing The color framing for the tape. For NTSC, the choice is Even or Odd. For PAL, the
choice is A Standard, A Non-Standard, B Standard, or B Non-Standard.

Creation Date The date and time the clip was logged/digitized.

Drive The last known drive on which the media for that master clip existed.

Duration The length of the clip.

End The timecode of the clip’s tail frame.
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FPS The play rate: the number of frames to be displayed each second. The default is
30 for NTSC and 25 for PAL.

Film TC The timecode for film. Used for 24p projects only.

Frame

n

The same frame that is displayed when you select Frame view for the bin. You can
perform the same operations on the frame that you can perform in Frame view, as
described in the editing or input/output guide for your Avid editing system.

The screen takes longer to display frames than text; using frames can slow the
work you do with bins.

IN-OUT The length of the marked segment, if any.

Ink Number The ink number for the clip. Used for 24p projects only.

KN Duration The length of the clip, expressed in feet and frames. Used for 24p projects only.

KN End The ending key number for the clip. Used for 24p projects only.

KN IN-OUT The Mark IN and Mark OUT key number for the clip. Used for 24p projects only.

KN Mark IN The key number for the IN, if you set one for the clip. Used for 24p projects only.

KN Mark OUT The key number for the OUT, if you set one for the clip. Used for 24p projects only.

KN Start The starting key number for the clip. Used for 24p projects only.

Labroll The labroll containing this clip.

Lock Specifies whether the clip is locked against deletion.

Mark IN The timecode for the IN, if you set one for the clip.

Mark OUT The timecode for the OUT, if you set one for the clip.

Modified Date The date and time a sequence was last edited or changed.

Table 4-1 Bin Column Headings (Continued)

Heading Description
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Offline The track names for any media files that are offline.

Perf The film edge perforation format.

Project The project under which the media was originally digitized.

Pullin The telecine pulldown of the first frame of the clip. Pullin can have the values A,
B, C, or D.

Pullout The telecine pulldown of the last frame of the clip. Pullout can have the values A,
B, C, or D.

Reel # The source reel number. Used for 24p projects only.

Scene The scene number of the clip.

Shoot Date The date the footage was shot.

Slip The information regarding how much quarter-frame slip is on this clip for sub-
frame-syncing.

Sound TC The timecode for audio.

Sound Roll The sound roll this clip came from.

Start The timecode of the clip’s head frame.

TC 24 The output format timecode. Used for 24p projects only.

TC 25 The output format timecode. Used for 24p projects only.

TC 25P The output format timecode. Used for 24p projects only.

TC 30 The output format timecode. Used for 24p projects only.

Take The take number of the scene.

Tape The source tape name.

Table 4-1 Bin Column Headings (Continued)

Heading Description
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Customizing Bin Views

The following methods are available for customizing Bin views:

• Alter the arrangement of existing columns in the standard
Statistics view or Film view to suit your needs, without adding or
hiding columns. These arrangements are recalled each time you
choose Statistics view or Film view.

• Add or hide columns of information to create customized
Statistics or Film views. These are saved as additional view
settings in numerical order (for example, Statistics.1, Statistics.2),
unless you select another name.

• Add, hide, copy, or rearrange standard or customized columns in
any combination to create your own custom views. You can name
and save these to suit your needs.

When you create a new Bin view, the system saves the settings
for this view so you can later access and alter, copy, or delete these
settings.

Tape ID The source tape name.

Tracks All tracks used by this media object.

VITC The vertical interval timecode.

Video The video resolution under which the media for that clip was digitized.

Table 4-1 Bin Column Headings (Continued)

Heading Description



75

Moving and Rearranging Columns

To move a text column in a bin:

1. Click the heading of the column you want to move.

The entire column is highlighted.

2. Drag the column to the position you want, and release the mouse
button.

The column appears in the new position, and columns to the right
are moved down to make room.

Aligning Bin Columns

When you align bin columns, the system maintains the same order of
columns from left to right but spaces them according to the width of
the contents. This is especially useful for removing spaces that remain
after moving or rearranging columns.

To align bin columns, choose Align to Grid from the Bin menu.

Showing and Hiding Columns

You can select individual or multiple bin headings to display or hide.

n Neither the Name column nor the Icon column can be hidden.

To select column headings to show or hide:

1. With a bin in Text view, choose Headings from the Bin menu. You
can also double-click a Bin View setting in the Settings scroll list of
the Project window.

The Bin Column Selection dialog box appears.



76

You can also display a
frame for each clip
along with statistical
information in Text
view by displaying the
Frame column.

2. Select the headings you want to add to the bin as follows:

• Click the name of a heading to select it.

• Click a highlighted heading to deselect it.

• Click Select All to highlight all the headings in the bin.

• Click Deselect All to deselect all the headings in the bin.

3. Click OK.

Only the headings highlighted in the dialog box appear in the bin.

Deleting a Column

When you delete a standard column, you can restore it at any time by
using the Bin Column Selection dialog box described in “Showing
and Hiding Columns” on page 75. When you delete a Custom col-
umn, however, you must re-create the column.
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To delete a column:

1. Click the column heading.

2. Choose Clear from the Edit menu, or press the Delete key.

The column disappears from the view, and surrounding columns
close to fill the space.

Duplicating a Column

You can duplicate existing columns containing timecode information
in other compatible columns that you target in a dialog box.

To duplicate a timecode column:

1. Select the column you wish to duplicate by clicking its header. For
example, click the Duration column heading.

2. Choose Duplicate from the Edit menu, or press Ctrl+D.

The Bin Selection dialog box appears.

In this example, the user has
selected the Duration col-
umn to duplicate; therefore,
“Copy Duration to” appears.



78

3. Select a column name from the list. The column must be of the
same type of data for the copy to occur.

For example, you can copy start timecodes to the Auxiliary TC1
column, but you cannot copy timecodes to the Pullin column.

4. Click OK.

The column of information appears in the column you designated.

Adding Customized Columns to a Bin

In addition to the standard statistical or film headings, you can add
your own column headings to describe information about clips and
sequences. For example, you might want to add a column heading to
describe what kind of shot (close-up, wide shot, master shot, extreme
close-up, and so on) is used in a clip.

To add a new column:

1. Move any existing column headings to the right, which creates an
empty area.

2. Click in the empty area.

3. Type your column heading name. Column headings must contain
fewer than 30 characters, including spaces.

4. Press Enter.

This puts the cursor in the data box, beside the first clip in the bin.
You can click in any row to customize the information for your
column.

5. Type the information you want, and press Enter to move to the
next line.
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6. Choose Align to Grid from either the Bin menu or the Fast menu.

The column heading names you create also appear at the bottom of the
list in the Bin Column Selection dialog box.

Changing a Custom Column Heading

You can change the heading name of custom columns only. You cannot
change any of the standard statistical or film column headings.

To change the name of a custom column:

1. Press and hold the Alt key, and click the heading to highlight it.

2. Type the new text for the heading, and press Enter.

Saving a Custom View

Anytime you add, hide, or delete a column, the Bin View name
changes to italic to indicate that it no longer matches the original view.
If you try to select a new Bin View setting while the current setting is
Untitled or italic, a message box appears and asks if you want to dis-
card the current setting.
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To save a Bin view:

1. Add, hide, move, or delete columns according to your preference.

n Each time you alter the view, a number is appended to the Bin View name and
the name changes to italic. The name remains this way until you save it.

2. Choose Save As from the Bin View pop-up menu.

The View Name dialog box appears.

3. Name the custom view by doing one of the following:

• To keep the default view name, click OK or press Enter.

• To create a new name for the custom view, type the name and
click OK or press Enter.

Bin View name and pop-up menu
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Setting the Bin Font

When you are in Text view, you can change the bin font, as follows:

1. Choose Set Font from the Edit menu.

A dialog box appears.

2. Choose a font from the Font pop-up menu.

3. If you want to use a larger or smaller point size, click the high-
lighted number next to the word Size, and type the size
you want to use.

4. Click OK.

Renaming Clips

In Text view, you can add an identifying name to each clip or
sequence, as follows:

1. Click the clip name to highlight it.

2. Type the new clip name, and press Enter.

A clip name can have a maximum of 256 characters, including
spaces.

n To modify information in other Text view columns of a bin, see “Modifying
Clip Data in a Bin” on page 91.

Selecting Clips

To select clips in a bin, do one of the following:

• Click the Clip icon.

• Select multiple clips by pressing the Ctrl key and clicking addi-
tional icons.
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• Select a range of clips by clicking the first clip in the range and
then Shift+clicking the last clip in the range.

To reverse your selection:

With one or more clips selected, choose Reverse Selection from the
Bin menu. The selection is inverted; that is, the clips you previ-
ously selected are deselected and those clips you previously dese-
lected are selected.

Deleting Clips and Sequences

To delete clips and sequences from a bin:

1. Select the clips you want to delete.

2. Choose Clear from the Edit menu, or press the Delete key.

The Delete dialog box appears, showing information about the
selected items (for example, one master clip).

To protect you from accidentally deleting important information,
the master clips, by default, are not marked for deletion.
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3. To mark a master clip for deletion, select the check box next to the
item. To exempt the master clip from deletion, select the check box
again.

4. Click OK; a dialog box appears.

5. Click Delete to confirm.

Duplicating Clips

To duplicate clips:

1. Select the clip you want to duplicate by clicking its icon.

2. Choose Duplicate from the Edit menu, or press Ctrl+D.

A copy of the clip appears in the bin and contains the clip’s origi-
nal name followed by the text Copy.01, indicating that this is the
first duplicate. The number appended to the name is incremented
for each additional duplicate.

For related topics, refer to “Moving or Copying Clips to Other Bins”
on page 90.

Copying Timecode Information

You can copy timecode data to an auxiliary timecode column. To copy
timecode information:

1. Select the timecode column you want to copy by clicking the
column heading. For example, click the Mark IN column heading.

2. Choose Duplicate from the Edit menu, or press Ctrl+D.

The Bin Selection dialog box appears.
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3. Select the column to which you want to copy the data.

4. Click OK.

If the column already contains data, a dialog box appears. Click
OK if you want to replace the existing values; otherwise, click
Cancel.

The timecode is copied to the column you selected.

Displaying Specific Clip Types

You can decide to display only certain types of media objects in a bin.
To specify what kinds of media objects to display in a bin:

1. Choose Set Bin Display from the Bin menu.

n Effect type clips cannot be displayed in the bins.

The Display Bin Selection dialog box appears.
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2. Select the object types you want to see.

3. Select either or both of the following options:

• Select “Show clips created by user” if you want the bin to dis-
play the object types you specifically created.

• Select “Show reference clips” if you want the bin to display
the object types that are related to the sequences in the bin, but
that you did not specifically create.

For example, the bin displays only the sequence if you do one of
the following:

• Store a sequence in the bin.

• Set the bin display to show either just the clips created by the
user or all the object types listed in the top of the dialog box.

If you also set the bin display to “Show reference clips,” the bin
displays all the objects related to that sequence. These related
objects might include master clips, motion effects, sources, and so
on.

4. Click OK.

Object types
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Sorting and Sifting Clips

You can sort or sift clips (and sequences) to find a specific clip or to see
clips that meet specific criteria.

• Sorting clips arranges clips in either numerical or alphabetical
order, based on the sorting criterion you choose.

• Sifting clips shows only clips that meet specific criteria.

The following sections describe both methods.

Sorting Clips

Clips within a bin can be sorted in alphabetical or numerical order.
The Sort command sorts multiple columns if more than one column is
selected. You can also reverse the order of the sort. When the selected
column is an alpha column, the Sort command sorts in alphabetical
order. If the selected column is a list of numbers, the Sort command
sorts in numerical order.

Sorting a Column

To sort clips in a column:

1. Click the heading of the column you want to sort.

The column is highlighted.

Column headings
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2. Choose Sort from the Bin menu, or press Ctrl+E.

MediaLog sorts the objects in the bin. In this case, the bin is sorted
alphabetically.

n If the Sort command is dimmed in the Bin menu, you have not selected
a column.

To reapply the last sort, choose Sort Again from the Bin menu. The
same column will be resorted. This is especially useful after you add
new clips to the bin.

Reversing the Sort Order

To reverse the order of the clips:

1. Click the heading of the column you want to sort.

The column is highlighted.

2. Press and hold the Alt key while you choose Sort Reversed from
the Bin menu, or while you press Ctrl+E.

MediaLog sorts the objects in reverse order.
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n If the Sort command is dimmed in the Bin menu, you have not selected a
column.

To reapply the last sort, choose Sort Again from the Bin menu. The
same column will be resorted in reverse alphabetical order.

Sorting on Multiple Levels

You can select multiple columns in a bin and perform a multilevel sort
using the information in the columns. The column that appears far-
thest to the left in the Text view of the bin becomes the primary object
for the sorting operation. You can rearrange the columns in the bin to
establish which column is primary.

Sifting Clips

Sifting clips allows you to list only those clips that meet certain crite-
ria. For example, you might want to list only the clips that contain the
word “water” in one or more of their heading columns.

Using Sift Criteria

To sift clips:

1. Choose Custom Sift from the Bin menu.

The Custom Sift Parameters dialog box appears.
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2. Choose a method for matching from the pop-up menus on the left:

• Contain

• Begin with

• Match exactly

3. In the text box, type the text you want the system to find.

4. Choose a column heading from the pop-up menu on the right.

The menu lists column headings in the current Bin view. To search
all the columns, select Any.

5. Follow steps 1 to 4 to enter additional sift criteria, if necessary.

6. Click OK.

The clips that meet the sift criteria appear in the bin.

Type the text you want to sift.

Choose a method
for matching.

Choose a column heading.
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Showing Sifted and Unsifted Views

After sifting the clips, you can view either sifted or unsifted material
by choosing either of the following from the Bin menu.

• Show Sifted

• Show Unsifted

n The check mark in the submenu indicates the current state of the bin. Unsifted
and sifted are dimmed in the submenu if sifting was not set up.

Moving or Copying Clips to Other Bins

To move or copy clips from one bin to another bin:

1. Create a new bin or open an existing bin.

If you create a new bin, give the bin a name that represents the
types of clips it will contain. For example, if you are putting all the
close-ups in the new bin, call the bin Closeup Clips.

2. Position the bins so you can see both of them at the same time,
resizing the bins if necessary.

3. In the original bin, click the icon of the clip you want to move.

4. Ctrl+click the icons of any other clips you want to move.
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5. Do one of the following:

• To move the clips, drag the clips to the destination bin.

• To copy the clips, press and hold the Alt key while you drag
them to the destination bin. Be sure to continue holding the
Alt key as you release the mouse button to drop the clips in
the destination bin.

The clips appear in the new bin.

When you copy clips from one bin to another, the custom columns
you created in the first bin are also copied to the second bin. The
custom columns appear in the order in which you created them.
The copied clip is displayed in the destination bin’s current format
(Frame view or Text view).

n If you set the destination bin’s display to show reference clips, the referenced
object types do not appear until you save the bin.

Modifying Clip Data in a Bin

You can modify data for master clips, subclips, tapes, and other objects
stored in a bin to correct data input errors or to add additional infor-
mation required for editing your project later.

Understanding Procedures for Modifying Clips

Two methods are available for modifying data in a bin.

• Modifying the data directly

You can change one item at a time by highlighting the data and
typing updated information. For example, you can type a new
name for a tape or correct the start and end timecodes for a clip.
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• Using the Modify command

You can use the Modify command to change some types of data
for a number of objects at the same time. For example, you can
increment the start and end timecodes for several master clips.

MediaLog automatically updates related objects to reflect any infor-
mation you modify. For example, if you change the timecodes and
names for a group of clips, the updated timecodes and names appear
in sequences created from the clips.

Some data can be modified anytime. Other data cannot be modified
after digitizing because changes would prevent you from playing back
and editing the material successfully.

Table 4-2 lists the data you can modify, the methods you can use to
make the modifications, and the times when you can make the modifi-
cations. You cannot modify data not included in the list.

Table 4-2 Bin Columns That Can Be Modified

Column Heading Modifying Method When to Modify

Name Directly Anytime

Start Directly or by using Modify command After logging, but before digitizing

End Directly or by using Modify command After logging, but before digitizing

Auxiliary TC1
through TC5

Directly Anytime
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Using the Modify Command

To modify data in bins by using the Modify command:

1. Open a bin and click the icon for a clip, sequence, or other object
you want to modify. Ctrl+click each additional object you want to
modify.

Select any object in the bin: master clips, subclips, sequences,
tapes, audiotapes, film reels, and so on.

2. Choose Modify from the Special menu.

The Alter Timecode dialog box appears.

3. Select the type of modification you want to make from the Modify
pop-up menu, and adjust any of the options associated with the
modification. See Table 4-3.

4. Click OK.

n You cannot modify columns of data. Always select master clips, subclips, or
other objects in the bin for modification, not columns.

Pop-up menu
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Table 4-3 Modify Command Options

Modification Options Description

Set Timecode Drop/
Nondrop

Drop, Nondrop Change the timecode format between drop-
frame and non-drop-frame.

Set Timecode By Field Start or End Change either the Start or End timecode.

Hour, Minutes, Second,
Frame

Enter custom timecode.

Increment Timecode Start or End Change either the Start or End timecode.

Timecode Enter custom timecode to increment.

Decrement Timecode Start or End Change either the Start or End timecode.

Timecode Enter custom timecode to decrement.

Set Key Number Generic
(Prefix)

Key Number Enter custom generic key number.

Set Pullin Punch frame timecode Set the timecode location of the punch
frame for pullin.

A, B, C, or D Select the pulldown frame to match to the
timecode entry.

Set Tracks V, A1 to A8 track selector Change the clip’s configuration of tracks.

Set Source No options Opens the Select Tape dialog box, where
you can select another source tape name for
the clip.
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Modifying Data Directly

To directly modify data in bins:

1. Click the data you want to modify.

The selected data is highlighted. Select only one item at a time. For
example, select a clip’s Auxiliary TC1 timecode. For a list of the
data you can modify directly, see Table 4-2.

2. Modify the data by doing one of the following:

• To replace the selected data with new information, type the
new data and press Enter.

• To permanently remove the selected data, press the Delete key,
or press Ctrl+X.

• To copy the selected data, press Ctrl+C. Select an item you
want to replace with the data you copied, and then press
Ctrl+V.

If you import a log file from your telecine transfer, much of this infor-
mation will be placed in the bin when you import the log. If you do
not have a film log, then you can enter this information manually by
highlighting the file in the bin and typing the information.

Selected data for modification
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CHAPTER 5

Creating MediaLog Output

Once you have finished logging your tapes, you can print the bins
to create a paper record of your log, export the bin files for use in a
different application, or transfer the bins to an Avid editing system for
digitizing and editing the footage.

This chapter includes the following topics:

• Printing Bins

• Exporting Bins

• Transferring Bins to an Avid Editing System

Printing Bins

Before you print MediaLog bins, make sure a printer driver has
been installed and that your computer recognizes the driver. If the
driver is installed properly, simply restarting your computer will
cause the system to recognize the driver.
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Directions for installing
the printer driver and
selecting the
printer should be
included in the docu-
mentation for your
printer and for your
computer system.

To print a bin:

1. Select the Bin view you want to print.

2. Choose Page Setup from the File menu. The Page Setup dialog box
appears.

3. Select the appropriate options from the Page Setup dialog box.
Available options depend on the printer.

4. Click OK.

5. Choose Print Bin from the File menu, or press Ctrl+P.

6. Select the print options, and then click Print.

Exporting Bins

You can save the bin information in a text file for use with other
applications. The information is saved in an ASCII file and is orga-
nized in the following way:

• Line 1 is a list of the headings in the current Bin view. This line is
optional.

• Each remaining line is data for an individual clip, with tabs delim-
iting each category of information. These lines are separated by
carriage returns.

The file can be opened in any word processing or text editing package,
or it can be imported into a database file created by applications like
Microsoft® Excel™ and Claris® FileMaker®.

The information can also be saved as a shot log in Avid format for
importing to an Avid editing system bin. This is generally unneces-
sary, because MediaLog bins can also be opened directly in Avid edit-
ing applications.
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To export a MediaLog bin:

1. Open the bin that contains the clips you want to export.

2. Select the clips.

3. Choose Export from the File menu.

The Export Settings dialog box appears.

4. Select the format you want to use for the exported bin.

5. Click OK.

6. Navigate to the disk and folder where you want to save the
exported file.

7. Click Save to accept the default file name, or type a new file name
and then click Save.

Transferring Bins to an Avid Editing System

Bins you have created on a MediaLog system can be transferred
to an Avid editing system and then opened directly from within an
Avid editing project.

The clips logged in the transferred bins are ready for batch digitizing;
no additional preparation is required.

It is best to transfer only bins, without projects, to the Avid editing
system. Then if you want, you can digitize the bins by using a different
video resolution.



99

To transfer MediaLog bins to an Avid editing system:

1. Save MediaLog bins on a formatted floppy disk.

2. Move to the Avid editing system, and quit the Avid editing
application.

3. Double-click the Avid Projects folder. Then double-click the
project folder where you want to store MediaLog bins.

Project folders are generally stored inside the Avid Projects folder.

4. Insert the transfer disk into the Avid editing system drive.

5. Double-click the floppy drive icon. The drive window opens.

Position the drive window and the Avid Projects window so you
can see both.

6. Select the MediaLog bins, and drag them into the Avid Projects
folder.

When you start the Avid editing system, use the standard process
to open the bins.
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APPENDIX A

Avid Log Specifications

This appendix explains how to format an Avid log. A sample log is
shown at the end of this appendix. When you create an Avid log, start
the file with global headings.

Tables in this appendix use the following conventions:

• Headings must be entered exactly as they are shown.

• <Values you enter appear in angle brackets. >

• <Alternative values appear on the next lines, also in angle
brackets.>

• [Tab and Enter keys are written in square brackets.]

• Explanations are written in italic.

See the “Sample Avid Log” on page 108 for an example of an .ale text
file.
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Global Headings

Global headings are case-sensitive and must be spelled exactly as
shown. Include all required headings. Other headings are optional but
might be necessary for your project. Do not use more than 64 headings
in the file, counting both the global and column headings. Table A-1
presents information about data in global headings.

Table A-1 Global Headings

Heading Name Key Entry Key
Required/
Optional Explanation

Heading — — [Enter] Required Marks the start of the global headings.

FIELD_DELIM [Tab] <TABS> [Enter] Required Enter TABS to show that the file is
Tab-delimited (delimited by tabs).

VIDEO_FORMAT [Tab] <NTSC>

<PAL>

[Enter] Required The video format is NTSC or PAL. In
NTSC format, you must edit in Cutlist
mode. PAL format allows you to edit at
either 24 or 25 frames per second.

AUDIO_FORMAT [Tab] <44 kHz>

<48 kHz>

[Enter] Required Audio sampling rate for digitizing. You
can override this for individual clips.

TAPE [Tab] <Tape
Name>

[Enter] Optional Name of the videotape reel you are log-
ging. If you omit this heading, the file
name becomes the global tape name. You
can override this for individual clips.

FPS [Tab] <24>

<25>

<29.97>

[Enter]

[Enter]

Required Capture rate is 25 fps for PAL and 29.97
fps for NTSC video.

Press Enter a second time, after you enter
the FPS value, to mark the end of the glo-
bal headings.
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Column Headings

When you create an Avid log, enter the column headings after the
global headings.

Column headings are case-sensitive and must be spelled exactly as
shown. Include all required headings; every statistical column heading
that is available in an Avid bin can be included. Other headings are
optional but might be necessary for your job. Do not use more than 64
headings in the file, counting both the global and column headings.
Table A-2 presents information about data in column headings.

Table A-2 Column Headings

Column Name Key
Required/
Optional Explanation

Column [Enter] Required Indicates the start of the column headings.

Name [Tab] Required Heading for clip name.

Tracks [Tab] Required Heading for tracks you select for digitizing.

Start [Tab] Required Heading for video timecode of sync point — the timecode IN
for clip. From address track of video.

End [Tab] Required Heading for timecode OUT for clip. From address track of
video.

AUDIO_FORMAT [Tab] Optional Heading for audio sampling rate for digitizing individual clip.
If omitted, the global entry for AUDIO_FORMAT applies.

Auxiliary TC1 [Tab] Optional Heading for auxiliary timecode.

Auxiliary TC2 [Tab] Optional Heading for auxiliary timecode.

Auxiliary TC3 [Tab] Optional Heading for auxiliary timecode.

Auxiliary TC4 [Tab] Optional Heading for auxiliary timecode.
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Auxiliary TC5 [Tab] Optional Heading for auxiliary timecode.

CFPS [Tab] Optional Heading for video capture rate for digitizing individual clip. If
omitted, the global entry applies.

Color Framing [Tab] Optional —

Creation Date [Tab] Optional Heading for date of clip creation.

Disk [Tab] Optional Heading for target disk ID.

Duration [Tab] Optional Heading for timecode Start to timecode End, the length of the
video clip.

FPS [Tab] Optional Heading for video frames per second rate for digitizing indi-
vidual clip (NTSC = 29.97, PAL = 25, Film = 24).
If omitted, the global entry applies.

IN-OUT [Tab] Optional Heading for duration between clip’s mark IN and mark OUT
(if present).

Mark IN [Tab] Optional Heading for timecode of clip’s mark IN (if present).

Mark OUT [Tab] Optional Heading for timecode of clip’s mark OUT (if present).

Offline [Tab] Optional Heading for tracks currently without digitized media files
online.

Tape [Tab] Optional Heading for source tape ID for individual clip. If omitted, the
global entry applies.

Video [Tab] Optional Heading for resolution compression ratios.

Labroll [Tab] Optional Heading for lab roll ID for clip. Lab rolls are a combination of
several camera rolls.

Camroll [Tab] Optional Heading for camera roll ID for clip.

Table A-2 Column Headings (Continued)

Column Name Key
Required/
Optional Explanation
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Sound TC [Tab] Optional Heading for Nagra timecode, Aaton code, ARRI code, and so
on, at the sync point. Syncs with the Start timecode. Required
if tracking the sync sound. Capture rate can be 25 or 30 fps.

Soundroll [Tab] Optional Heading for sound roll ID for clip.

Scene [Tab] Optional Heading for scene ID for clip.

Take [Tab] Optional Heading for take ID for clip.

DESCRIPT [Tab] Optional Heading for description of clip.

COMMENTS [Tab] Optional Heading for comments about clip.

<Your_headings> [Tab] Optional Press the Tab key between each heading. Do not press the Tab
key after the last heading. Add any category of information
you want. Add as many headings as you want, but do not use
more than a total of 64 global and column headings in the file.

[Enter]

[Enter]

Press Enter twice (not the Tab key) after the last heading.

Table A-2 Column Headings (Continued)

Column Name Key
Required/
Optional Explanation
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Clip Data

Enter a line of data for each clip you log. The word “Data” marks the
start of the data for each clip.

Enter the information under the appropriate column headings. Press
the Tab key instead of typing data if you want to leave an optional cat-
egory of information blank for a particular clip. Press Enter at the end
of each line. Include all the required data. Other data is optional.
MediaLog supports up to four audio tracks in imported and exported
logs. Table A-3 presents information about clip data in the log.

Table A-3 Clip Data

Clip Name Key
Required/
Optional Explanation

<clip name> [Tab] Required Under Name heading. Enter a clip identifier (32 characters
maximum).

<V>

<VA1>

<VA2>

<VA1A2>

<A1A2>

<A1>

<A2>

[Tab] Required Under Tracks heading. Enter the tracks you want digitized
for the clip. Enter V for MOS takes. Enter A1, A2, or A1A2
for wild sound.

<44 kHz>

<48 kHz>

[Tab] Optional Under AUDIO_FORMAT heading. Audio sampling rate
for this clip only. If omitted, global entry applies.

<source tape ID> [Tab] Optional Under Tape heading. Source videotape ID for this clip only.
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<24>

<25>

<29.97>

[Tab] Optional Under FPS heading. Video capture rate for this clip only.
If omitted, global entry applies. Use 25 fps for PAL video,
29.97 fps for NTSC video, or 24 fps for Film.

<time code> [Tab] Required Under Start heading. Video timecode for sync point, the first
frame in clip. Use colons for non-drop-frame timecode (for
example, 01:00:12:20). Use one or more semicolons for
drop-frame timecode (for example, 01;18;00;02).

<time code> [Tab] Required Under End heading. Video timecode for last frame of clip.

<time code> [Tab] Optional Under Duration heading. Length of video clip, Start to End.

<lab roll ID> [Tab] Optional Under Labroll heading. Identify the lab roll by using letters
and numbers.

<camera roll ID> [Tab] Optional Under Camroll heading. Identify the camera roll by using
letters and numbers.

<time code> [Tab] Optional Under Auxiliary TC heading. Enter a Nagra timecode,
Aaton code, ARRI code, and so on for the sync point. Syncs
with the Start timecode.

<sound roll ID> [Tab] Optional Under Soundroll heading. Identify the sound roll using let-
ters and numbers.

<scene ID> [Tab] Optional Under Scene heading. Identify the scene using letters and
numbers.

<take ID> [Tab] Optional Under Take heading. Identify the take using letters and
numbers.

Table A-3 Clip Data (Continued)

Clip Name Key
Required/
Optional Explanation
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<clip description> [Tab] Optional Under DESCRIPT heading. Write about the clip.

<clip comments> [Tab] Optional Under COMMENTS heading. Comment on the clip.

<information> [Tab] Optional Press the Tab key between each heading. Do not press the Tab
key after the last heading. Under the headings you created
yourself, enter the appropriate information.

[Enter] Press Enter (not the Tab key) after the last entry for the clip.

Enter an additional line of data for each remaining clip.

Table A-3 Clip Data (Continued)

Clip Name Key
Required/
Optional Explanation
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Sample Avid Log

This is an example of an Avid log for an NTSC video project.

Heading

FIELD_DELIM TABS

VIDEO_FORMAT NTSC

AUDIO_FORMAT 44khz

FPS 29.97

Column

Name Duration Tracks Start End Auxiliary TC1 Audio CFPS

Data

WILDLIFE 29;01 VA1A2 12;03;44;18 12;04;13;21 19;56;58;02 48
kHz 30.00

WATERFALL 20;09 VA1A2 13;06;11;01 13;06;31;10 18;54;31;21 48
kHz 30.00

WATER EDGE 24;25 VA1A2 13;46;25;04 13;46;49;29 18;14;17;18 48
kHz 30.00

SUN IN
ROOTS 1;15;26 VA1A2 13;47;43;03 13;48;58;29 18;12;59;17 48
kHz 30.00



109

APPENDIX B

Using Help

Help is available through the Avid MediaLog Help system. This
appendix describes the following procedures:

• Opening and Closing the Help System

• How Help Windows Work

• Finding Information with the Help Topics Dialog Box

• Using Buttons in a Help Topic

• Printing Help Topics

• Copying Information from a Help Topic

• Changing the Font Size of Help Topics

• Keeping Help on Top

• Changing the Color of Help Windows

• Adding a Note to a Help Topic
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Opening and Closing the Help System

To open the Help system, choose MediaLog Help from the Help menu.
The Help Topics dialog box appears.

To close the Help system, click the Close button in each Help window.
The Help system closes when you close the last open Help window.

How Help Windows Work

The Help system consists of the Help Topics dialog box and three
types of windows:

• The Help Topics dialog box opens in the center of your screen by
default. The Contents tab contains a list of overview topics cov-
ered in the Help system. Double-click any Book icon to see addi-
tional topics. Double-click a topic or select a topic and click the
Display button to open a window containing the information you
seek.

• The MediaLog How To window opens on the right side of your
screen. It displays procedures for completing tasks. You can close
this window or leave it open as you work. Each time you click a
new How To topic, the window displays the new information. You
can cycle back through the topics by clicking the Back button.

• The MediaLog Reference window opens on the left side of your
screen. It contains background information, tables of options, or
other information that helps you understand system features and
tools. Each time you click a new Reference topic, the window dis-
plays the new information. You can cycle back through topics by
clicking the Back button.

• Pop-up windows open from screen objects and from glossary
items. You cannot move or resize pop-up windows.
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Finding Information with the Help Topics Dialog Box

A topic is a single page of the Help system. The Help Topics dialog box
includes three different methods for finding topics.

• Using the Contents Tab

• Using the Index Tab

• Using the Find Tab

Using the Contents Tab

The Contents tab provides a list of categorized topics that covers the
entire Help system. The list is organized by book. Each book opens to
display a list of topics.

To view the Contents, do one of the following:

• From the Help menu, choose Avid MediaLog Help, and then click
the Contents tab, if it is not already displaying the Contents.

• From a Help topic, click the Contents button.

To open a book and display a list of topics, select the book title and
click Open, or double-click the book title.

To open a Help window, select the topic and click Display, or
double-click the topic title.

Using the Index Tab

The Index tab has an alphabetized list of entries.

To find topics by using the Index tab:

1. From the Help menu, choose Avid MediaLog Help and click the
Index tab, or click the Index button in a Help topic.
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2. In the text box at the top, type a keyword for the topic that you
want to find (for example, type “tracks” to jump to index entries
listed under tracks).

3. Open the topic in the list:

• If your typing brings you to the topic you are seeking, click the
Display button, or double-click the index entry.

• If you do not immediately arrive at the topic, scroll through
the list and double-click an entry that makes sense, or try an
alternative keyword in the text box. When you find the subject
you are looking for, click the Display button or double-click
the entry to view the topic.

Using the Find Tab

The Find tab lets you search the entire Help system for words or
phrases and then lists topics that include those words or phrases.

To search for topics by using the Find tab:

1. From the Help menu, choose Avid MediaLog Help and click the
Find tab.

2. In the text box, type the word or phrase you want to find.

A list shows topics that contain the words you searched for. As
you type additional words, the list updates.

n Do not type quotation marks or asterisks in the text box.

3. To change how you search for a word or words, click the Options
button and choose your preferences.

4. Select a topic in the list and then click the Display button or
double-click the topic.

The topic is displayed, and the words you searched for are high-
lighted.
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Using Buttons in a Help Topic

Each Help topic contains buttons to help you navigate through the
system and perform basic functions. Table B-1 describes the Help
topic buttons.

Table B-1 Help Topic Buttons

Button Description

Contents Opens the Contents tab.

Index Opens the Index tab.

Find Opens the Find tab.

Back Returns to the previously displayed topic.

Print Prints the current topic.

Options Provides the following features:

Annotate Allows you to add a note to a topic

Copy Allows you to copy information to another
document.

Print Topic Prints the current topic.

Font Allows you to choose a size for text.

Keep Help
on Top

Displays the Help window on top of other
applications.

Use System
Colors

Allows you to choose a color for Help
windows.

Glossary Opens a glossary of terms.
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Printing Help Topics

You can print a single Help topic or a group of topics listed in the
Contents.

To print an open Help topic:

1. Open or click the topic to make it active.

2. Click Print in the topic window, or click Options and choose
Print Topic.

3. Select the print options.

4. Click OK.

To print a topic or book of related topics from the Contents tab:

1. Select the topic or book you want to print.

2. Click the Print button.

The Print dialog box appears.

3. Select the options you want and click OK.

Copying Information from a Help Topic

To copy information from a Help topic into another document:

1. In the topic window, select the text that you want to copy.

2. Click Options and choose Copy.

3. Choose Paste from the Edit menu to paste copied text into a docu-
ment in another open application, such as a word processor.

You can also paste the text into the keyword text box in the Index
tab or into the text box in the Find tab.

n You cannot paste text from one topic into another.
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Changing the Font Size of Help Topics

To change the font size of Help topics:

1. Open or click a How To or Reference window to make it active.

2. Click Options and choose Small, Normal, or Large from the Font
submenu.

Keeping Help on Top

By default, the Help window remains on top of other application win-
dows. This feature lets you refer to a Help topic while you are com-
pleting a MediaLog task.

To change the Keep Help On Top setting:

1. In a Help topic, click Options.

2. Choose Keep Help on Top, and then choose either Default, On
Top, or Not On Top. The default is to keep Help on top (which is
the same as choosing On Top).

Changing the Color of Help Windows

The Help system uses two different colors for the display areas of win-
dows. Reference windows are white, and How To windows are pale
yellow. You can replace this color scheme with the single windows
color (typically white) that is set for your system in the Windows
Control Panel.
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To use the system color for Help windows:

For information on
changing the color set-
tings for your entire
system, see the docu-
mentation for your
operating system.

1. Open or click a How To or Reference window to make it active.

2. Click Options and choose Use System Colors from the pop-up
menu.

3. Click Yes in the message box.

4. Choose MediaLog Help from the Help menu.

Follow the same procedure to revert to the two-color scheme.

Adding a Note to a Help Topic

To add a note to a Help topic:

1. In the Help topic window, click Options.

2. Choose Annotate.

3. In the dialog box, type your note and then click Save.

A paper-clip icon appears at the top of the topic. Click this icon to see,
edit, or delete your note.
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APPENDIX C

Regulatory and Safety
Notices

FCC Notice

This device complies with Part 15 of the FCC Rules. Operation is sub-
ject to the following two conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including inter-
ference that may cause undesired operation.

This equipment has been tested and found to comply with the limits
for a Class A digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed in accordance with the instruc-
tion manual, may cause harmful interference to radio communica-
tions. Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be required to
correct the interference at his own expense.
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Canadian ICES-003

This Class A digital apparatus meets all requirements of the Canadian
Interference Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du
Règlement sur le matériel brouilleur du Canada.

European Union Notice

Declaration of Conformity
(According to ISO/IEC Guide 22 and EN 45014)

Application of Council
Directives:

73/23/EEC, 89/336/EEC.

Standards to which
Conformity is Declared:

EN 60950: 1992 + A1 + A2 + A3 + A4
IEC950: 1992 + A1 + A2 + A3 + A4: 1993 Mod.
CISPR 22:1985 / EN 55022:1988 Class A
EN 50082-1:1992 / IEC801 -2, -3, -4

Manufacturer’s Name: Avid Technology, Inc.
1925 Andover Street,
Tewksbury, MA 01876, USA

European Contact: Nearest Avid Sales and Service Office or
Avid Technology International B.V.
Sandyford Business Center
Unit 3,
Dublin 18, Ireland
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(1) The product was tested in a typical Symphony, Avid Xpress with
Deluxe Bundle for the Windows NT Operating System, Avid Xpress
with Elite Bundle for the Windows NT Operating System, or Avid
Media Composer configuration.

I, the undersigned, hereby declare that the equipment specified above
conforms to the above Directives and Standards.

George R. Smith, Director of Quality Engineering

Australia and New Zealand EMC Regulations
John Kells, Australian Operations Manager
Avid Technology (Australia)
166 Epping Road
Lane Cove N.S.W.
Sydney, Australia 2066
Phone: 011-612-9937-1800

Type of Equipment: Information Technology Equipment

Product Name: Media Composer for the Windows NT and Macin-
tosh Operating Systems, Film Composer, Sym-
phony, Avid Xpress for the Macintosh Operating
System, Avid Xpress with Plus Bundle for the Mac-
intosh Operating System, Avid Xpress with Deluxe
Bundle for the Windows NT and Macintosh Operat-
ing Systems, Avid Xpress with Elite Bundle for the
Windows NT and Macintosh Operating Systems

Base Model Numbers: All for the Windows NT Operating System;
Avid Xpress, 1000, 1000 XL, 9000, MC Offline,
MC Offline XL, and Media Station for the Macintosh
Operating System

Product Options: All

Year of Manufacture: 1999

N1709
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A
AatonBase, importing 64
Accessing Compression tool 55
Adding bin columns 78
ALE (Avid Log Exchange)

converting logs with 64
logs compatible with 64

Align columns in a bin 75
Align to Grid command (Bin menu) 75
Archiving files 39
Attic folder 35
Audio settings

Compression tool 56
Autoconfigure All Ports (Special menu) 43
Automatic deck configuration 43
Automatic saving 37
Auxiliary timecode column, copying timecode

information to 83
Avid log

importing 64
sample, created with text editor 108
specifications

clip data 105
column headings 102
global headings 101

Avid Log Exchange See ALE
Avid Projects folder 19

B
Backups

attic 35
to disk 39

Bin views, customizing 74
Bins

automatically saving 37
backing up 39
closing 31
column headings in 71, 102
columns in

adding 78
aligning to grid 75
duplicating 77
headings for 71
moving 74
showing and hiding 75
tidying up See Align to Grid command

creating new 30
display, setting 84
exporting 97
font, changing 81
headings 71
lists, viewing 29
opening from other projects 33
removing from project 32
reopening 32

Index

A B C D E F G H I L M N O P Q R S T U V
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retrieve 35
saving manually 36
sifting clips in 88
target, selecting for logging 54
Text view

custom 70
film 70
statistics 70
unsifted view 90
using 69

transferring 98
transferring from a MediaLog system 66
working with 29

C
Channel dialog box 45
Channel Selection area 54
Clear command (Edit menu) 77, 82
Clip data, Avid log specifications 105
Clip types in bins, specific 84
Clips

copying to other bins 90
deleting from bins 82
duplicating in bins 83
modifying in bins 91
moving to other bins 90
organizing 69
removing from bins 82
renaming in bins 81
sifting in bins 86, 88
sorting 86
sorting in reverse order 87
specific types, displaying in bins 84

Closing
a project 29
bins 31
the Help system 110

Commands
Align to Grid (Bin menu) 75

Autoconfigure All Ports (Special menu) 43
Clear (Edit menu) 77, 82
Custom Sift (Bin menu) 88
Duplicate (Edit menu) 77, 83
Headings (Bin menu) 75
Import (File menu) 65
Modify (Special menu) 93
Page Setup (File menu) 97
Print Bin (File menu) 97
Reverse Selection (Bin menu) 82
Set Bin Display (Bin menu) 84
Set Font (Edit menu) 81
Show Sifted (Bin menu) 90
Show Unsifted (Bin menu) 90
Sort (Bin menu) 87
Sort Again (Bin menu) 87
Sort Reversed (Bin menu) 87

Composer Projects folder See Avid Projects
folder

Compression tool 55
Compression, understanding 55
Configuring decks 44

automatically 43
manually 43

Connecting deck to computer 14
Contents tab

in Help Topics dialog box 111
Copying clips and sequences to other bins 90
Copying text from a Help topic 114
Creating

new bins 30
new projects 21
new users 20

Custom Sift command (Bin menu) 88
Customizing Bin views 74

saving 79



122

D
Data, modifying in bins 91
Deck

automatic configuration 43
configuration settings 44
connecting 14
deleting configuration elements 49
manual configuration 43
not connected, logging with 61
offline 61
preferences, table of 49
settings, table of 46

Deleting
clips from bins 82
deck configurations 49
sequences from bins 82

Displaying
memory 28
profile 28
set bin 84
sifted views in bins 90
specific object types in bins 84
unsifted views in bins 90
usage 28

Duplicate command (Edit menu) 77, 83
Duplicating

bin columns 77
clips in bins 83
sequences in bins 83

E
Evertz, importing 65
Excalibur, importing 64
Existing project, opening 24
Exporting bins 97

F
Files, backing up 39
Film, Text views in bins 70
Find tab

in Help Topics dialog box 112
FLEx, importing 65
Font

changing size in Help topics 115
Font, changing in bins 81

G
Global headings in Avid log 101

H
Hardware

setup 14
turning on 15

Headings
bin column 75
column, in Avid log 102
global, in Avid log 101
show and hide 75

Headings command (Bin menu) 75
Help system

buttons in topic windows 113
changing font size of topics in 115
closing 110
Contents tab 111
copying text from 114
Find tab 112
Help Topics dialog box 111
Index tab 111
opening 110
printing a topic from 114

Hiding bin columns 75
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I
Import command (File menu) 65
Importing logs 63
Index tab

in Help Topics dialog box 111
Info button 28
Information about project 28
Installing MediaLog 16, 17

L
Listing bins 29
Log files, importing from film-to-tape transfer

systems 95
Log Producer, importing 64
Log Right, importing 64
Log, Avid

clip data, specifications 105
column headings, specifications 102
global headings, specifications 101
sample, created with text editor 108

Logging
basic steps 12
defined 41
directly to bin from source tape 56
information from active tracks 54
on-the-fly 60
preparing for 51
source tape, identifying 55
target bin for 54
without a tape 61
without deck connected 61

Logging tool 51
Logs

importing into MediaLog bins 65
importing, standard 64

M
MediaLog

importing logs into 65
overview 9
quitting 40

Memory, displaying 28
Menu commands See Commands
Modify command (Special menu) 93
Modifying data in bins 95
Moving

bin columns 74
clips and sequences 90

Multilevel sorting 88

N
Naming tapes 52
New Project dialog box 21
New User dialog box 20

O
Objects in bins

displaying 84
modifying 91

Offline 61
Online Help See Help system
Open Project dialog box 20, 21
Opening

an existing project 24
bins from other projects 33
existing bins 32
the Help system 110

Organizing projects 68
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P
Page Setup command (File menu) 97
Print Bin command (File menu) 97
Printing

Help topics 114
Printing bins 96
Profile, displaying 28
Project

file 19
folder 19
organizing 68
video format 25
window 25

Projects
See also Bins, Clips, Sequences
automatically saving 37
closing 29
creating new 21
working with 18

Q
Quitting MediaLog 40

R
Removing

clips from bins 82
sequences from bins 82

Renaming
clips in bins 81
sequences in bins 81

Reopening bins 32
Retrieving bin files from the Attic folder 35
Reverse Selection command (Bin menu) 82

S
Saving

bins 36
custom bin views 79

Selecting an existing project 24
Sequences

copying to other bins 90
deleting from bins 82
duplicating in bins 83
moving to other bins 90
removing from bins 82
renaming in bins 81
sifting in bins 86
sorting 86
sorting in bins 86
sorting in reverse order 87

Set Bin Display command (Bin menu) 84
Set Font command (Edit menu) 81
Setting up hardware 14
Shot Lister, importing 64
Show Sifted command (Bin menu) 90
Show Unsifted command (Bin menu) 90
Sifted views in bins 90
Sifted views, displaying in bins 90
Sifting

clips in bins 86
clips in bins, custom 88
sequences in bins 86

Sort Again command (Bin menu) 87
Sort command (Bin menu) 87
Sort Reversed command (Bin menu) 87
Sorting 86

in bins 86
in reverse order 87
multilevel 88

Specifications
clip data 105
column headings 102
global headings 101
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Statistics
column headings 71
Text views in bins 70
viewing 28

Subclips in bins, modifying 91

T
Tape, naming schemes 52
Tapes in bins, modifying 91
Target bin for logging 54
Telecine, importing log file from 95
Text view in bins 69
Tidying up columns in a bin See
Timecode information, copying to auxiliary

column 83
Transferring

bins from another MediaLog system 66
bins to an Avid editing system 98

Trash, emptying 26
Turning on the hardware 15

U
Unique tape names 52
Unsifted views, displaying in bins 90
Usage, displaying 28
User, creating new 20
Using bins from other projects 33

V
VTRs See Deck


	Title Page
	Contents
	List of Tables
	Understanding MediaLog
	What Is MediaLog?
	How Does MediaLog Work?
	What Are the Basic Logging Steps?

	Getting Started
	Setting Up the Hardware
	Turning On the Hardware
	Installing MediaLog Software
	Starting the System
	Setting Up Project Files and Folders
	About Project Files and Folders
	Creating a New User
	Creating a New Project
	Choosing Matchback and Film Options
	Selecting an Existing User or Project
	Using the Project Window
	Displaying Project Bins
	Displaying Project Settings
	Displaying Project Information
	Closing a Project and the Project Window


	Working with Bins
	Creating a Bin
	Closing a Bin
	Reopening a Bin
	Removing Bin Names from the Current Project
	Opening Bins from Other Projects
	Retrieving Bin Files from the Attic Folder

	Saving Your Work
	Saving a Bin
	Saving All Bins
	Saving a Copy of a Bin
	Setting Auto-Save Bin Preferences
	Backing Up Files

	Shutting Down
	Quitting the MediaLog Application
	Turning Off the Hardware


	Logging Source Material
	Understanding Logging
	Configuring Decks
	Automatic Deck Configuration
	Manual Deck Configuration
	Deck Configuration Settings
	Deleting Deck Configurations
	Deck Preferences


	Preparing to Log Material
	Accessing and Setting Up the Logging Tool
	Guidelines for Naming Tapes
	Inserting Source Tapes
	Selecting Active Tracks
	Selecting the Bin
	Selecting the Source Deck
	Identifying the Source Tape

	Using the Compression Tool

	Logging
	Logging from a Source Tape
	Marking and Logging
	Logging While Marking an OUT Point or an IN Point
	Using the Go To Buttons

	Logging On-the-Fly
	Logging with the Deck Offline

	Creating Avid Logs
	Importing Logs
	Importing Standard Log Files
	Compatible Logs
	Importing Log Files into MediaLog Bins
	Transferring Bins from Another MediaLog System


	Organizing Clips and Bins
	Organizing Clips and Sequences
	Viewing Clips in a Bin
	Customizing Bin Views
	Moving and Rearranging Columns
	Aligning Bin Columns
	Showing and Hiding Columns
	Deleting a Column
	Duplicating a Column
	Adding Customized Columns to a Bin
	Changing a Custom Column Heading
	Saving a Custom View
	Setting the Bin Font

	Renaming Clips
	Selecting Clips
	Deleting Clips and Sequences
	Duplicating Clips
	Copying Timecode Information
	Displaying Specific Clip Types
	Sorting and Sifting Clips
	Sorting Clips
	Sorting a Column
	Reversing the Sort Order
	Sorting on Multiple Levels

	Sifting Clips
	Using Sift Criteria
	Showing Sifted and Unsifted Views


	Moving or Copying Clips to Other Bins
	Modifying Clip Data in a Bin
	Understanding Procedures for Modifying Clips
	Using the Modify Command
	Modifying Data Directly


	Creating MediaLog Output
	Printing Bins
	Exporting Bins
	Transferring Bins to an Avid Editing System

	Avid Log Specifications
	Global Headings
	Column Headings
	Clip Data
	Sample Avid Log

	Using Help
	Opening and Closing the Help System
	How Help Windows Work
	Finding Information with the Help Topics Dialog Box
	Using the Contents Tab
	Using the Index Tab
	Using the Find Tab

	Using Buttons in a Help Topic
	Printing Help Topics
	Copying Information from a Help Topic
	Changing the Font Size of Help Topics
	Keeping Help on Top
	Changing the Color of Help Windows
	Adding a Note to a Help Topic

	Regulatory and Safety Notices
	FCC Notice
	Canadian ICES-003
	European Union Notice
	Australia and New Zealand EMC Regulations

	Index

